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Version Control 

Document guide version 1.02 

Relating to Application version 1.071 

 

Contact details and help 

E-mail ian@iansapps.co.uk 

Web http://iansapps.co.uk/filelister/ 

Facebook https://www.facebook.com/pages/Ians-
Apps/553440324742053  

Application demonstration video Listing files and attributes 

Changing filenames 

 

Important Note (possible error) 

64 bit versions of Office will probably return the error shown below when the 
standard version of FileLister is used, so the downloaded file also includes a 
64bit version which will overcome this issue. If you see the error shown below 
when opening GetFileList, then please use the 64 bit version. All functionality 
remains the same. 
 

 

mailto:ian@iansapps.co.uk
http://iansapps.co.uk/filelister/
https://www.facebook.com/pages/Ians-Apps/553440324742053
https://www.facebook.com/pages/Ians-Apps/553440324742053
http://iansapps.co.uk/filelister/videos/filelist.mp4
http://iansapps.co.uk/filelister/videos/changenames.mp4
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History of the FileLister application 

The idea for FileLister was conceived many years ago when the need arose for several hundred 
documents to be updated and I realised that Windows did not provide a facility to list the names 
of documents contained within a specified directory (and its sub-directories) in an editable 
format. There isn’t even a facility to print a list without taking a screenshot of Windows Explorer, 
pasting it in Word, returning to Windows Explorer, taking a screenshot of the next set of 
documents, pasting it into Word etc. What a labourious process!  

As I wanted a log of which documents had been updated (and with what) for future reference, I 
wrote a very rough application to create a simple list of the filenames within a directory in a 
spreadsheet. This served my purpose at the time (and on future occasions), but it was very 
clunky and not at all user friendly so I kept it to myself, quietly saving myself lots of time. 

A couple of years later, I found myself spending yet another hour on a Sunday morning 
changing “IMG3465.JPG” to “The Kids 001.JPG”, “IMG3466.JPG” to “The Kids 002.JPG” etc. 
Even using copy and paste and manually incrementing the suffix number, it was incredibly 
labour intensive selecting each file and changing the name (especially with over 200 photos!) so 
I returned to FileLister and added the functionality to change the names of files extracted within 
the application. This is incredibly handy in Excel as the ability to write a formula and autofill 
makes it a 30 second job. 

Colleagues saw me using this app, mainly for the purpose of listing the contents of a directory 
(though renaming does have its uses in the office) and commented as to how useful it seemed, 
so I decided that it probably deserved a release, so I tidied it up, added extra file properties (25 
in total in the current release, with the choice to select which properties you would like to see) 
and made it intuitive and user friendly. 

The instructions for using this very useful app can be seen below. If you don’t have a copy on 
your hard drive yet, please visit the website (www.iansapps.co.uk) and buy yourself a copy. 

Compatibility 

This application has been tested on: 

 Windows XP 

 Windows 7 

 Windows 8/8.1 

 Windows 10 

Using Excel from: 

 Office 2007 

 Office 2010 

 Office 2013 

It has not been tested on Office 2016 or Office 365, but there is no reason to believe that it won’t 
work on either of those releases. 

 

 

http://www.iansapps.co.uk/
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Instructions 

Please follow the instructions carefully in order to get the most out of FileLister. 

1. Opening and enabling the application 

This is application is written in Microsoft Excel and uses Visual Basic for Applications (VBA) 
code to carry out its job. Whilst this may not mean much to you, or even interest you, it is 
important that you have Microsoft Excel set up in such a way that it allows the code (known as a 
Macro) to run. 

To check (and amend if necessary) your macro security settings:  

1. On the Developer tab, in the Code group, click Macro Security 

 

 

 

Note: If the Developer tab is not available display it by: 

1. Click the File tab, click Options, and then click the Customize Ribbon category. 

2. In the Main Tabs list, select the Developer check box, and then click OK. 

3. Click any other tab to return to your file. 

 

2. Make sure that your macro settings are as below (or to ‘Enable all macros’, though this isn’t 

recommended). ‘Disable with notification’ means that Macros will be automatically disabled, 

but you well get a notification whenever you open a new Excel file that contains Macros, 

giving you the opportunity to enable or disable. 

 

 

 
3.  When opening, if prompted, you should ‘Enable Macros’  
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Or the security warning may display between the ribbon and the formula bar, depending on 
your settings: 
 

 
 
In which case, you should click ‘enable content’. 
 
(In Excel 2007, you may be presented with this message 

 
 
In which case, you should click options and select ‘enable this content’.) 
 

 
 
You are now ready to list your files. 
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2. Listing files within a specific directory 

a) Getting started 

To display the FileLister menu, click the ‘Add-ins’ tab and the FileLister dropdown will be 
displayed (see image below). 

 

To create a list of files (and the properties of those files that you wish to include), click 
‘Summarise files held within a specified directory’. This will present you with a dialogue box 
which will give you the option to select which attributes you wish to display. 

b) Selecting file attributes to display 

On clicking the menu item the following form will be displayed on your screen. 

 

Check the boxes relevant to your requirements to tell the application which file attributes you 
wish to display.  
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To remove all of the attributes from your selection for one of the three categories, simply click 
the ‘Clear All’ button within the relevant category box. Similarly, to select all the attributes for 
one of the three categories, simply click the ‘Select All’ button within the relevant category box. 

To clear or select all of the attributes for all three categories, click the larger ‘Clear All’ or ‘Select 
All’ buttons, respectively, in the bottom right corner of the form above OK & Cancel. 

When you first run FileLister, all file attributes will be checked as a default. You can amend this 
default using the ‘FileLister Preferences’ option on the menu. See below for instructions as to 
how to amend your preferences. 

The filepath and filename of each file will be extracted to columns A & B by default (clicking 
‘Clear All’ will mean that your extract shows only these two attributes). 

The ‘Maximum number of data rows per sheet’ box will be populated with the maximum number 
of rows allowed in a single Excel Worksheet by default. You need only amend this value if you 
would like to have a specfic number of rows in each sheet. Please note that should the number 
of files being listed exceed this number then the listing will continue on a new sheet. Please see 
the demonstration video at http://iansapps.co.uk/filelister/videos/filelist.mp4 

You should be aware that the more attributes being selected, the longer the listing will take to 
create. 

Once you have selected your attributes and maximum number of rows, click OK to proceed 

c) Choosing which directory to list 

You will now be presented with a standard Windows dialogue box that will enable you to 
navigate to the directory that you wish to list. 

 

The default start point of this navigation can be set by using the ‘FileLister Preferences’ option 
on the menu. This will be useful if you regularly interrogate the same directory. See below for 
instructions as to how to amend your preferences. 

Please be aware that the contents of all subdirectories of the directory that you choose will be 
included. 

http://iansapps.co.uk/filelister/videos/filelist.mp4
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Once you have selected your directory, click OK. The file properties will now be extracted to 
Excel. Your numerical progress can be viewed in the bottom left hand corner of Excel. Please 
note that on a large run, or when lots of attributes have been selected, this number will freeze 
after a while. Do not panic, it’ simply the application putting your cmputers processor to better 
use. 

 

The data can now be saved/used as desired. 

3. Changing file names 

a) How to change your filenames 

Before you change any file names, you will need to have extracted a list of files as per the 
instructions above. It should be noted that only the first three columns of the FileLister output 
are relevant for the change filename functionality, i.e. Path, Filename & New Filename. These 
columns must be in this order, in columns A, B & C respectively, and no columns should be 
inserted within them. 

The process is really simple. Populate column C with the new filename (just the filename, no 
path) and select ‘Change File Names’ from the FileLister menu. Any rows with column C left 
blank will see the name of the file listed in that row remain unchanged. 

 

Once the renaming has completed, you will be advised that the task is complete. 
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In the example screenshot above, you will note that column D is populated. This is because I 
want to give each file the same name, but with an incrementing suffix, so I have typed a short 
formula in cell C2:  

="Amended name "&D2&".txt" 

I have then typed ‘001 (note the apostrophe to denote a text field, otherwise the 2 leading 
zeroes will disappear and you will find number 2 appearing after 19 when you sort your files 
alphabetically) into cell D2. For those not familiar with Excel formulae this is telling Excel to 
populate C2 with “Amended name “ and the value in cell D2 (i.e. 001) and the file extension 
“.txt”. 

I have then used Excels autofill function to complete columns C & D down to the end of the list 
of files.  

Some level of data sorting may be required before you write these formulas, depending on your 
requirements. For example, you may have a directory full of photos taken from 2 or more 
cameras which use different default naming conventions and you would like to rename the files 
with the same text name and a numerical suffix based on the date and time stamp of the photo. 
In this case you would make sure that when you list your files through FileLister you include the 
‘Date Taken’ property and then sort your data by that column. 

Please see the demonstration video at http://iansapps.co.uk/filelister/videos/changenames.mp4 
for more details and other examples. 

b) Possible errors when re-naming files 

There are a number of errors that can occur when renaming files, and the application will check 
for the following: 

1. When re-naming your files there are certain characters that Windows will not allow you to use. 
There are 10 of these characters and they are:  

/ ? < > / : * | " ^ 

2. Windows also limits the total number of characters allowed in a filepath and filename to 255 
(where C:/Windows/test.txt is 19 characters) 

3. You must add a file extension to your name (e.g. .txt, .jpg, .docx etc). The application will not 
check the validity of your extension (as there are thousands and thousands of possible file 
extensions), just that you have added one. 

4. The filepath shown in column A must exist and the file noted in column B must exist within the 
filepath shown in column A. 

5. You cannot have two files with the same name in the same location. 

http://iansapps.co.uk/filelister/videos/changenames.mp4
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The application will check your inputs for all of these potential errors and will report and failures 
on a fresh sheet. Please see the example below: 

 

Errors 

 Row 3 does not have an extension 

 Rows 6 and 7 have the same name 

 Row 9 has an invalid character 

 Row 10 has accidently lost some characters from the end of the filepath 

 Row 12 has a filepath and name which is 629 characters long. 

On running ‘Change File Names’, these errors will be picked up and you will be advised. NO 
files will be renamed, but you should note that the list will now be ordered alphabetically by 
column C, so in my example Rows 9 and 12 will now be found at the bottom of the data. 

 

An Errorlog sheet is alluded to in this message and this will be created within the application 
and populated.  
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You should view this sheet, and amend your new filenames accordingly before trying again. 

 

 

4. Amending your preferences 

FileLister stores a couple of preferences to make consistent use easier, for example where you 
regularly run it against the same directory with the same attribute requirements. You can set a 
default directory and you can set default attributes selection. You will still be presented with the 
folder and file attributes selections when running the process, enabling you to navigate 
elsewhere and add/remove attributes, but they will have defaulted to your preferences. 

To access your preferences select ‘FileLister Preferences’ from the FileLister menu. 

 

You will then be presented with the preferences form. 
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a) Default Filepath 

The currently set Default Filepath (the location on your computers structure from which you wish 
to extract file information) will be displayed in the Default Filepath frame of the form. To change 
this, or to set a Default Filepath where none has been previously selected, click the ‘Change’ 
button and navigate to your preferred directory using the dialog box that will appear. Once you 
have made your selection, click OK. This will return you to the FileLister Preferences form and 
update the information 

 

b) Default attribute selection 

Clicking ‘view’ in the Default attribute selection frame will present you with the attribute selection 
form discussed in 2(b), above. Select which attributes you would like this form to be pre 
populated with when it appears during the summarise Files process and click OK.  

 
When you have made changes to either of these preferences, you must close the form by 
clicking Save, otherwise no changes will be saved. 

 

Feedback 

I’d love to hear your feedback on this application. Good points, bad points and what you find the 
application useful for. Tell me how this application saves you time. Please e-mail all your 
comments to ian@iansapps.co.uk  
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